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Introduction

Welcome! These short examples, which involve HIV-1 Protease and known inhibitors, will teach you the essentials
of carrying out docking calculations using Vdock.

You will learn how to load ligands and a receptor, set up the parameters of a calculation, carry it out, and then
how to visualize the results.

The Vdock graphical interface is designed to guide you through this process. The steps that need to be taken are
laid out along the top as a row of buttons, starting with Load Ligands and ending with View Results. Each section
has its own interface to aid you in the tasks specific to that stage.

If you run into any trouble or would like to explore aspects of the software beyond what is described here, you can
access the full documentation from the Help menu at the top of the window. This document can also be accessed
from the same menu.



Preparing to run the examples

The first thing you should do is to make a copy of the example files for your own use. This preserves the original
copy that was installed with the software and is necessary on some systems because file permissions can prevent
writing to the installation directory.

Navigate to the install location of Vdock. If you picked the default location this will probably be c:\Program
Files (x86)\VeraChem\Vdock
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Copy the examples directory and paste it to a location of your choice (Documents works well) You might wish to
rename the new directory from examples to vdock_examples to make it easier to find in the future.
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HIV Protease and XK263




This example involves docking the cyclic urea inhibitor xk263 to HIV-1 protease using the 1hvr PDB structure.

Start up Vdock by double-clicking on the blue desktop icon labeled VDock Interface. You can also open the Start
menu and type vdock into the search field. That should display the Vdock Interface link as well.
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Select New Project from the dialog in the center of the screen

Navigate to vdock_examples\1lhvr_xk263 and pick a name for your project and select Open
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File name: m - |Verachem Docking Project (*.d| v|

[ Open l | Cancel |

Select the Load Ligands button at the bottom left
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Pick XK2_model.sdf and click Open

This file contains the xk263 inhibitor from the PDB file 1hvr. It is in the conformation found in that
co-crystal structure.

xk263 will appear in the 3D graphics window
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Select the Load Ligands button again and this time pick xk263_from_2D_vconf.sdf and click Open .

This file contains a different conformation of xk263. This time the molecule was drawn in 2D using
VeraChem's Vdraw software and then Vconf used to convert this to 3D and carry out a
conformational search to find low energy conformations. This conformation is the lowest energy
one that was found. We are including it to demonstrate a realistic scenario in which one might want
to dock a molecule for which you have no docked conformation already and one must start from
scratch with a 2D structure. This is considerably more challenging then simply redocking a ligand
that was extracted from a complex pdb structure.

After the load it complete you will see two entries in the Available Ligands box at the bottom of the window.
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https://www.verachem.com/products/vdraw/
https://www.verachem.com/products/vconf/

Next select the Setup Ligand Flexibility button at the top of the window.
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The Setup Ligand Flexibility window is used to control how much flexibility in the ligand

will be sampled during the docking calculation. Vdock only searches around rotatable bonds (it
does not change bond angles or lengths). It is here where you can decide which rotatable bonds to

sample and what range to sample over.

Next, select the Auto Setup All Ligands at the bottom

Set sampling width and center using entries or sliders.
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The Auto Setup All Ligands button can be used to implement the most common sampling

scheme, that is to sample all rotatable bonds in all ligands over their entire range. This is the most
common option to select. If, in the future, you wish to limit sampling then you can use the other
tools on this page to do so.

Now select the Load Receptor button at the top to switch to the window for loading your receptor.
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This window is used to load the receptor structure you will use in the docking calculation. This is
also where you can choose the molecular mechanics force field to use and carry out the assignment

of parameters.



Click the Load Receptor button at the bottom and select 1hvr.pdb in the file selection dialog that appears.

Then click open.
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| Remove Water Parameters: Present
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The Charmm19(polar H) forcefield is selected by default. Charmm22(all atom) is also a

supported option.

The receptor structure will be displayed in the 3D graphics window.

Project Calculation  Help

m 0.2 - C\Users\mpotter\Documents\vdock_examples\lhvr_xk263\example_xk263.dpr

| - Labels |

Label | Atom Number  w |

Label Al

Measure
dist. angle dih.

| Clear Last || Clear All |

| - Atom Selection |

v | molecule 1

Mouse Click Selection
(o ) [Reses
Res Mum
Res Name
Atom Num
Atom MName
=
Distance
[Save seicton
(1) (2 [ ) 5+
Named |Last5el.7V|
[0 ) (o] [x0m |

| Load Ligands || Setup Ligand Flexibility | Load Receptor |

Selection
|T| |m| |a| Receptor Information:
e /| Remove Water Parameters: Present
| - Graphics | Receptor Forcefield:
|W| |Charmm19[polar H) v|
| Hide ” Show | | Load Receptor |
Ol OR

Define Binding Site

” Setup Receptor Flexibility ” Run Docking Calculation

= || B || ER
A-At+ At

Information regarding loading of the receptor structure and it's parameterization is displayed in the console
window, separate from the main graphical interface.
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Any ligands that are detected during the loading process will be saved in pdb format in the same directory as the
project file. The filename(s) will be reported in the console window. You can see that one such ligand was found. If
any errors occur during this process they will also be displayed in the console window.

Next, select the Define Binding Site button at the top of the main window.
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This window is used to specify the region of 3D space that will be searched by the ligands during
the docking process. This is a user-defined cube which is usually centered on a known binding site
of the receptor.

In this case, we know that the ligand XK2 is in the binding site of the receptor, because it was built from the ligand
present in the 1hvr pdb structure. So, we can use it to place the sampling box.

Make sure that XK2 is selected and highlighted in blue in the Available Ligands box at the lower right, then
click the Center on Ligand button in the bottom center.
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The sampling box will move to the binding site.

This cube may also be placed either manually, using the Place Box button and the mouse, or it

can be placed on a reference structure, loaded specifically for the task, or on any set of selected
atoms, using the Center on Selection button. Please see the full Vdock documentation, which

can be found in the Help menu for details.



For purposes of this example we will skip the Setup Receptor Flexibility window. It is used to select rotatable
bonds in side chains of residues in the receptor to sampling simultaneously with the ligand.

So, now select the Run Docking Calculation button at the top of the window.
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This window is used to select which ligands to dock from those you have loaded and prepared.
You can also set the search parameters which govern the length and thoroughness of the docking.
On the right are controls for actually excuting the calculation and monitoring its progress. There are
many adjustable parameters that can be accessed using the More Parameters... button, but
the main ones are available from the main window. Docked Conformations sets the number of
conformations of the ligand, docked to the protein that you would like to generate. Trial
Conformations is roughly the number of different conformations that will be generated for each
of the docked conformations produced. Out of the total number of trial conformations, the one
with the lowest potential energy will be selected. That is, if Docked Conformations is set to 20
and Trial Conformations to 3000, then 20 searches of 3000 trial conformations each will be
run. The lowest energy from each search will be saved as one of the 20 docked conformations
produced. See the full documentation, accessible from the Help menu for details.



Click the Dock All Ligands button on the left panel to select both ligands you have prepared for docking.
Now click the Run Complete Calculations button on the bottom left of the right panel.

Status:  Minimization of docking results complete

Calc
[ calatecid || Optimize Ligand Alone ||
[ StartDoding ||  MinimizeDocked ||
| RunComplete Caloulations || write

This will start the docking calculations for the selected ligands and will following those calculations
with a number of other calculations which can help in interpretation of the results. These include a
conformational optimization of the ligands by themselves, without the protein present, as well as
minimization of both the conformations found for the ligands by themselves and the docked
conformations. This is helpful as the docking algorithm itself only optimizes the energy with respect
to position, orientation, and rotatable bonds. A full minimization extends that optimization to the
remaining degrees of freedom (bond lengths and bond angles for example).

While the calculations are executing in the background, a process that should take only a few minutes, the
docking GUI will display information about which ligand is being docked and the progress of the individual
calculation that is running at that point (might be docking, ligand alone optimization, or minimization). Docked
conformations are displayed as they are found.
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click the view Results tab at the top right.
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which will take you to the View Results interface.
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This window provides a wide range of tools that aid in the visualization and interpretation of the
results of your calculations. You can view single or multiple conformations of each ligand in 3D
along with the protein. You can simultaneously view quantitative energy information on the right as
well as a graph of a selected quantity over all available conformations. Comprehensive controls for
labeling and view control are at the left side and at the bottom right are buttons that provide a
number of other useful tools. See the full documentation for details, available in the Help menu.



There are very large number of things that can be done from this window. For now we will look at just a few of the
basics. When you arrive at the window is will be showing the docked confirmation for the selected ligand (shown in
the Available Ligands box at the bottom center) with the lowest potential energy.

To make things a little easier to see, let's display only the portion of the protein that is within 5 Ang of the ligand.
To do this, type 5 into the Distance to Lig field on the left in the Atom Selection panel and hit enter.
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You will see all protein atoms withint 5 Ang of the ligand highlighted with purple crosses.

Now, let's save this selection for use later. Select the Save Selection button just below where you entered the
distance based selection. Then click S1 to save it in that memory location.
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The Atom Selection panel allows you create complicated selections very easily by assembling them from simple
'building-block' selections using logical operations like AND, OR, and XOR in combination with the four selection
memory locations S1-4

Let's see how this works by creating a selection that contains all atoms within 5 Angstroms of the ligand as well as
all other atoms in the protein backbone. This will provide needed detail near the ligand while still providing
enough the rest of the protein structure to help maintain your frame of reference.

To do this, use the drop down menu below the memory buttons to select Prot. Backbone
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Selection
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Now, click the OR button and then click S1 This will take the current selection, the protein backbone, and
combine it with the selection in S1 (atoms within 5 Ang of the ligand) using a logical OR operation. This is
equivalent to a union set operation.

Now scroll down slightly using the scroll bar on the left to reveal the Show Only button on the Graphics panel
and click it. This will show only the atoms in the current selection, that is all atoms either in the protein backbone
or within 5 Ang of the ligand.



You can alter this display to color all the atoms within 5 Ang of the ligand by element to make things easier to
interpret. To do this, select the S1 button where you saved the 5 Ang distance based selection earlier. Now, on
the Graphics panel, to the left and just below the Atom Selection panel find the color by Property
dropdown menu and select Element
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This should be the result:



The Atom Selection panel offers many ways to construct simple selections which then may be saved and
combined using logical operations to create very precise and complex selections. These can in turn be used to
tailor the display in many different ways.

For example, one could highlight the positions of all ASP residues in the protein. First, select All at the bottom of
the Atom Selection panel, then on the Graphics panel on the Solid dropdown, pick Blue . This just resets
the color of all atoms (other than the ligand) to blue.

Now, type 'ASP' into the Res Name field of the Atom Selection panel and hit enter:



Mouse Click Selection
|E| |F!.E5i-:|ur-_-:; |
Res Num
Res Name  ASP|
Atom Mum

Atom Mame

Selection

| All | | Invert | | Clear |

COLOR
Salid | Blue

Property | Element

Now find the Solid dropdown on the Grpahics panel and select Orange

There are numerous other combinations that could be made. Remember that you can use the S1-4 buttons to




save and return to different selections.

Lets return to just looking at the area near the ligand. Select the S1 button. This will recall the 5 Ang ditance-
based selection you made earlier. Now, on the Graphics panel, select Show Only
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This will change the 3D view to display only the ligand the and atoms that you selected (those within 5 Ang of the
ligand)

If you wish to restore all atoms to view in the future, click the A1l button at the bottom of the
Atom Selection Panel then the Show button onthe Graphics panel.

Now, let's take a look at the rest of the View Results interface:
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The View Results interface provides a wide range of tools for visualization and analysis of your results. At the
bottom are controls that govern which ligand and which of the found conformations for the ligand to display in
the 3D window.

Available Ligands:
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Select the ligand of interest from the Available Ligands list. This will display the lowest energy docked
conformation found for that ligand. The rest of the conformations found are available, in order from lowest to
highest energy as well. You can move through them using the Forward and Back buttons. As you move through
the conformations you will see the rank number of the conformation update in the center bottom and If you
would like to view all of them at once, select Show All

Along the right side is a graph of potential energy over all conformations as well as a table of energy components
and possible other properties for the ligand currently in view. You can graph any of the properties in the table by
clicking on the underlined titles.
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Note that what is referred to in the table as Binding Energy is just the potential energy of the
complex minus the potential energy of the ligand by itself (available only if the ligand alone
calculation has been carried out) This adjusts for the change in ligand energy that occurs as it
moves from free in solution to bound. The protein conformation does not change during binding,
unless some side chains have been mobilized, so in most cases this is the only adjustment needed
to convert the potential energy of the complex to a rough estimate of binding energy. Since the
energy of the ligand alone is the same for all bound conformations this does not change the
relative energy between docked conformations, it only effects the magnitude. This is just a potential
and not a free energy and the approximations made in the energy model, especially for solvation
are significant. This is not expected to be a useful estimate of actual binding energy, only a rough
measure of the strength of the binding as indicated by the energy model used for docking. The
purpose of Vdock is to find good, low energy, candidate conformations for protein ligand systems.
It is not intended to predict binding affinity. For prediction of true free energies of binding for
host-guest and protein-ligand systems please see VeraChem's VM2 software package at
https://www.verachem.com/products/vm2/

Below the energy component and property table are a number of other controls that allow you to change the
order in which the conformations are sorted, their display characteristics, load reference structures for comparison,

calculate RMS vs a reference, export conformations for use in other applications, and display two different types of
VdW contacts.


https://www.verachem.com/products/vm2/
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Let's load a reference structure to use in evaluating the docking results. Very often you will have at least some 3D
structural information about binding to your receptor. This can be useful in evaluating and understanding the
results even if, in the majority of cases, you will be docking ligands for which you have no experimental data on
binding conformation.

In this case one of the source structures we used for the ligands is, in fact, the ligand taken directly from a co-

crystal structure. To load this as a reference structure click the Load Ref Structure button at the bottom right
and select the XK2_model.sdf file.

As you can see, the reference structure is rendered in red and the lowest energy docked conformation is quite
similar to it. We can quantify this similarity by calculated the root mean squared (RMS) difference between the
reference structure and each of the 20 docked conformations.

It is currently only possible to do this if the number and order of the atoms in the reference structure matches
those in the ligand. This is the case now. So, click on the RMS vs. Ref button at the bottom right.

VDock correctly accounts for symmetry when computing RMS and will not be 'fooled' by cases in which symmetric



groups have been flipped or when the entire symmetric ligand might be bound rotated relative to the reference.

The RMS values of each ligand conformation can be viewed in the Property table (you may need to scroll the list
down to reveal it):
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Click on the title in the table, RMS to update the graph at the upper right to show the RMS values for all 20
docked conformations.
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In this case, since we started the docking for the ligand XK2_model from coordinates that were directly taken from
a co-crystal structure docking was very successful in finding the 'right' conformation, and all 20 are quite close to
the experimental reference.

You can also see this by selecting the Show All button at the bottom center.
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This high accuracy and low variance in the conformations located by VDock is mostly due to the unusual case of
using a ligand from a crystal structure, in which all the bond lengths and angles are precisely what they were from
the experimental structure. VDock only varies rotatable bonds during the search. In the case of HIV Protease and
cyclic urea inhibitors like XK263 here, the ligand fits very tightly and precisely into the active site so there is little
room for variation. That also contributes to the degree of success observed.

Let's take a look at the more realistic and usual case: when you are docking a ligand that you have drawn from
scratch in 2D and then converted to 3D for docking.

From the Available Ligands list at bottom center, select Xk263_2D_mol_1. Now select Show All



You can see that the variation is much larger. This is a much more challenging case that with XK2 and gives you
some idea of how big an impact having prior experimental structural information about ligands can have.

Select the Clear Strs button at the bottom right and then replace the 20 in the center entry field with a 1:

‘ Show Al

- 7‘ Invert

This will display only the conformation with the lowest potential energy. You can type any set of numbers,
separated by spaces into this field to display the corresponding structures. For example, to see the first four lowest
energy conformations, type '1 2 3 4' and hit enter.

For now, go back to just structure 1.

This is the conformation with the lowest potential energy. Let's say you would like to compare this one with the
other structures that were found, but viewing them all at once is too much. The Keep button allows you to
desinate structures that you wish to remain in view even as you move to others using the Forward and Back
buttons.

Try it now, select Keep . You will see the numbers field now contains 1 1 instead of just 1.
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Now try clicking Forward
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The numbers / ranks to display field now contains 1 2 and both structures 1 and 2 are displayed in the 3D
window. You can make the structures easier to separate by selecting Color By and Structure on the right:
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To make the ligand even easier to see try selecting Tubes in the Draw Style dropdown (found right below the
Color By control that you just used.)

This should be the result:

Now let's load up a reference structure to evaluate the docking of this set of ligands. Remember that the ones we
are viewing now, Xk263_2D_mol_1, were not taken from an experimental crystal structure like XK2 but instead
were drawn in 2D, then converted to 3D and docked.

Change the display to show only docked conformation 1 byt deleting the current contents of the center structure
field (currently containing 1 2) and typing in just 1 and hitting enter.

Now, select the Load Ref Structure button on the right and then pick the file XK2_model.sdf



This is what you should see:

The reference structure is shown as a red line rendered structure. Notice that the lowest energy docked
conformation, in grey, is actually in a conformation upside down relative to the correct structure (represented by
the reference we just loaded, which is from the pdb crystal structure for the complex)

In fact, if you move through the conformations using the Forward button you will see that the 'correct' structure
is the 3rd in terms of potential energy. This is a good lesson. The energy function used for docking and the model
used specifically in this implementation is not accurate enough to reliably rank conformations at a detailed level.
This is partly because of approximations made in the molecular mechanics force field and partly because of other
factors. These include the fact that the protein-ligand interaction energy is interpolated off of a 3D grid to speed
evaluations during the search. Also, only degrees of freedom involving rotatable bonds (dihedrals) are optimized in
the search, bond lengths and angle remains as they were at the start. Protein side-chains that are not specifically
selected for search are also kept rigid. The model for solvation used, a very simple distance dependent dielectric, is
not sufficiently accurate for fine distinctions between ligands. Also, it is not the potential energy that determines
conformations in any case, it is the free energy. Evaluation of the free energy is a much more difficult and time-
consuming task as it requires a careful consideration of entropic effects.

These are all beyond the scope of VDock, which is designed rather to provide a reasonable set of good
conformations for docked ligands in a rapid and efficient manner. It is often capable of locating a structure similar
to the actual one, somewhere within the set of low energy conformations that are located, but it will quite often
not be the one with the lowest potential energy.

The output of VDock is the therefore most useful for use in a qualitative sense, or as the starting point for further



calculations. For example, VDock can be an excellent source of a diverse range of high quality starting
conformations to use with the VM2 free energy package Starting from reasonable conformations can greatly
accelerate the VM2 calculation.

VDock does offer some simple additions that can help with the ranking problem however. For example, when you
ran all the calculations in the Run Docking tab, you requested that the docking conformations located all be
minimized in all-degrees of the freedom and without the 3D gridded and interpolated interaction energies.

The results of this minimization can be explored by selecting the Min. Docked button at the bottom, under the
Available Ligands box.

Available
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This is what you should see (you may need to select Tubes from the Draw Style control on the right, again,

after selecting Min. Docked ).

Notice that the lowest potential energy structure is now very close to the reference! In fact, now the first upside-
down structure is ranked 18th!. This is a much better ranking.


https://www.verachem.com/products/vm2/

So, you can see that even a little extra calculation can greatly improve the results. Starting from a 2D, sketched,
structure VDock is capable of locating conformations very close to the actual crystal structure and, following
minimization, able to rank them reasonably well too. It is very important to keep in mind that this extra
minimization was required however, and also that results this good will not always be obtained. Again, VDock
generally will find something close to the actual structure, somewhere in the batch of structures it generates, but
they might not be the ones scored the 'best’, that is they may not be those with the lowest potential energy.

For this case, using the ligand drawn in 2D and not directly from the crystal structure, it is not possible to compute
and RMS relative to the reference structure as we did above. This is because the atoms are in a different order in
the ligand and reference structure files. VDock does not yet have the capability to find the correct corresponding
atoms on its own. This is something that we are working on.

If you do try to compute RMS vs the reference structure (using the RMS vs. Ref button) you will see an error
message about the mismatch in atom order:

@®% The order of the heavy atems in reference structure does not match

2 ! that of the ligand structure,

Please select a reference structure that has heavy atoms in the same
order as those in the ligand structure,

Let's consider two other features that are useful now. The first of these is the ability to measure distances between
atoms. To do this, go to the Labels panel at the top left. You may need to scroll the control panels in order to
reveal it. Then select Distance from the Display dropdown menu.
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When you do this, you will be prompted on the 3D window status bar to select two atoms:

Select two atoms...
Available Ligands:
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You can select atoms by Shift-Left-Click on them int he 3D window. Try this now, first picking one atom from
the ligand and then another from either the protein or the reference structure. When an atom is selected it will be
drawn as a small, red, sphere.

If you wish to deselect an atom you can just Shift-Left-Click it again. In this case pick two atoms. When the
second atom is selected the distance between them will be calculated and displayed. It is interesting to pick two
atoms similar to those in the following example:



Now you can move through the ligand conformations and the distance label will update to show the distance
correct for the conformation that is being displayed. If you display more than one conformation then both
distance will be displayed.

Try this by typing 1 18 and hit enter in the structure number field in the center just below the 3D window.
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This can be a nice way to look for structures that differ from each other in some key way. In order to make this
easier it is also possible to convert the distance label into a property, which then be displayed in the conformation
properties area on the right. It will then also be possible to both graph by that property and even to sort the
structures by that value as well.

To do this, go back to the Labels panel at the top left. Then click on the Make Property button.

If this button is disabled and light grey it probably means that neither of the atoms you selected
are from the ligand. If this happens then try clicking Clear Last and then selecting two more
atoms, one of which should be from the ligand.

Now, you should be able to find the distance on in the property table on the right. You might have to scroll to find
it as it will probably be at the bottom of the list.
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Here the property is titled, Dist. 25 1387 as it is the distance between atom 25 of the ligand and atom 1387 of the
protein.

Now, left click on the title Dist 25 1387 in the property table. This will update the graph at the top right to
display this distance.

Dist. 25 1387
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This makes it very easy to observe the way that the property in question, in this case the distance, varies across all
of the conformations found by VDock. In this case, you can see which conformations are 'upside down' relative
because this results in a larger distance (structures 18 and 19 in this case). Note that you can left click on an
portion of the graph to jump to the corresponding conformation in the 3D window.

You can also sort the conformations by any of the properties in the table. Try this with the distance. Go to the
Sort By control just below the property table and select Dist 25 1387 (or whatever the title is for the atoms
you selected) from the dropdown list.

The conformations will now be sorted from lowest to highest by that property. Structure 1 will now be the
conformation with the lowest value for that property. You can see the impact of the sorting by the graph at the
top right.
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You can check for correlations between different properties by sorting by one and then graphing another. This
should reveal any links between them. For example, sort by Potential Energy and graph Total vdW Att. and
the graph should look something like this:
A-A+ BT
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You can see that there is no real correlation between overall potential energy and just the attractive portion of the
VdW potential. This is a somewhat contrived example as one wouldn't necessarily expect a such a correlation. It is
the total VdW, the sum of the attractive and repulsive components that is more likely to be correlated. You can
click on the Total VdW property to graph that.
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Now let's look at how you can export conformations found by Vdock for use in other software. To do this display
the conformations you wish to export in the 3D window. This can be done any way you prefer, either by navigating
to them with the Forward and Back buttons, using the Keep button to build a set, or by directly entering the
structure numbers you wish to display in the text field at bottom center. IF you wish to export all of of the
conformations you can use the Show All button.

After displaying the structures you wish to export, select the Export button on the right.
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This will open a dialog in which you can select a location, filename, and file format to use. The supported formats
at the moment are multi-structure pdb, sdf, the trj format (a modified multi-structure pdb file), and numbered,
separate crd files.



I hope you have found this tutorial helpful to you. There is more to explore in the interface and with VDock in
general. Please refer to the main documentation file, accessible in the Help menu at the top.

Feel free to experiment with different settings to see their effect on the results. In order to change input settings,
add ligands, or change run parameters you will need to clear the current results. This will unlock all the of the
buttons and controls that are grey and disabled when results are present. This happens as the interface acts as a
record of the setting used to generate the current results. You can close and open the same project file and look
back at the contents of each of the tabs to see how the calculation was set up and run. Disabling changes when
results are present prevents the setting from getting out of sync with the results.

If you wish to clear results to make changes, you might also wish to save a copy of the current state for reference
later. To do this, go to the Project menu at the top left and select Save Copy . Then select a location and name
to use. It is best to place this copy in its own directory as there will be a number of files, not just one. The name
you choose will form the basis for the filenames in that directory. So, if you pick project_xk263 then all the files
will be named that, with various suffixes.

Marne Size
|| ] project_xk263.dpr | 1.29 MB
|| project_xk263-Xk263_20_rmol_L-minimized.trj 115 KB
|| project_xk263-Xk263_2D_mol_1-minimized.out 17.5KB
|| project_xk263-Xk263_20_meol_1-conformation.trj 150 KB
|| project_xk263-Xk263_20_mol_1-conformation.out 716 KB
|| project_xk263-Xk263_20_mel_1-docking.trj 150 KB
|| project_xk263-Xk263_2D_mol_1-docking.out 703 KB
|| project_xk263-Xk263_20_rmol_L-minimizedLig.tr] 115 KB
|| project_xk263-Xk263_2D_mol_1-minimizedLig.out 16 KB
|| project_xk263-XK2-minimized.trj 115 KB
|| project_xk263-XK2-minimized.out 17.5 KB
|| project_xk263-XK2-conformation.trj 150 KB
|| project_xk263-XK2-conformation.out 76 KB
|| project_xk263-XK2-docking.trj 150 KB
|| project_xk263-XK2-docking.out T18 KB
|| project_xk263-XK2-minimizedLig.trj 115 KB
|| project_xk263-XK2-minimizedLig.out 16 KB
|| project_xk263_grid.out 635 KB
# | project_xk263_nbdc.grd 126 MB
| project_xk263_nbdb.grd 126 MB
f | project_xk263_nbda.grd 126 MB

Now, navigate to the Load Ligands tab and you can clear the current results by going to the Project menu at
the top left and selecting Clear and then Results and then Non-Bonded Grid . You should now be free to
make any changes you wish and then run the calculations again.

One thing you might wish to try is to start a new project entirely (close the interface and the restart it) and then, in
Load Ligands select the file Xk263_from_2D _mol_1_ confs.sdf instead of XK2_model.sdf or
Xk263_from_2D_vconf.sdf

This file contains the nine lowest energy energy conformations found when the 2D sketch of xk263 was converted
to 3D by VeraChem's VConf software. If you remember, the file we used earlier, Xk263_from_2D_vconf.sdf
contained just a single structure from the 2D sketch. That was the lowest of the nine in this new file. Sometimes it
can be good, especially since VDock only searches rotatable bonds, to start from a number of different
conformations of the ligand, if you have some means (like VConf) of generating them. You could then dock all of
them and pick the lowest energy conformations found across all of the runs.


https://www.verachem.com/products/vconf/

This concludes the tutorial / example involving HIV Protease and the inhibitor XK263.

HIV Protease and the UMASS series of ligands

The second example provided with your installation of Vdock involved HIV Protease again, but this time with a
series of 40 ligands developed at the University of Massachusetts:

Ali, A; Reddy, G. S. K. K,; Cao, H.; Anjum, S. G.; Nalam, M. N. L,; Schiffer, C. A.; Rana, T. M. Discovery of HIV-1
Protease Inhibitors with Picomolar Affinities Incorporating N -Aryl-Oxazolidinone-5-Carboxamides as Novel P2
Ligands. J. Med. Chem. 2006, 49 (25), 7342-7356. https://doi.org/10.1021/jm060666p.

These ligands are all quite large and very different from the cyclic urea inhibitor XK263 that we looked at in the
first example. Here are a few examples from the set:
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These ligands are a greater challenge to dock properly than the cyclic ureas because they are large, relatively
flexible and less 'pinned' down by specific electrostatic interactions with the receptor.


https://doi.org/10.1021/jm060666p

Vdock can still be quite successful with them however.

I will not go through the entire process of setting things up and docking them here as it is very similar to that used
for XK263.

You can follow the same process as for XK263 only you should navigate to the vdock_examples\2ied_ad_81
directory and create a project there.

Then use the files ad_81_model.sdf and ad_81_ from_2D.sdf in place of XK2_model.sdf and
Xk263_from2D_vconf.sdf . These are both the ligand AD81 and the first is in the conformation taken directly
from the crystal structure of its complex with HIV protease. The second is AD81 drawn in 2D and then converted to
3D using VeraChem's Vconf software.

Remember that you can load ad_81_model.sdf as the reference molecule in View Results to compare the
docked conformations to that from the actual crystal structure.

Once you get a feel for the type of ligand represented by AD81 you can try out the other 40 members in the series
by loading them from the file umass_1_vconf.sdf

Explore the results obtained from the docking (remember that minimization in all degrees of freedom ( Min.
Docked in View Results ) often gives better results than the unoptimized docked structures.


https://www.verachem.com/products/vconf/
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Shown here is the ligand AD78 compared to the crystal structure of AD81.

This concludes the Vdock tutorial / examples. I hope you found these examples interesting and helpful in learning
about Vdock and how to apply it effectively. We appreciate your interest and hope you go on to do interesting
things with the software!
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